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There is so much you can 

do in Photoshop that it can 

be a little overwhelming. 



These are some of my  

“go to tricks” for getting 

amazing results FAST. 





I hope you find this useful 

and as always feel free to 

let me know what you 

think!

To download all the source files used, go to

www.kelvindesigns.com/psbook

I’ve written 
these formulas 
for everyone! 

2 0  P H O T O S H O P  F O R M U L A S

Welcome!

Kelvin Pimont

(Kelvin Designs)

Is an award-winning Creative 

Director and industry-leading 

educator. Kelvin has taught 

hundreds of thousands of 

Photoshop users how to break 

free from the confusing technical 

jargon, helping them create 

better art in less time.
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Workspace
To get the most out of this book, your Photoshop 
Workspace should be set to “Essentials”
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Workspace

If your Photoshop does not look like this, or you 
moved something around, you can always “reset” 
the workspace to the way it was when you first 
started Photoshop.

To reset Photoshop Workspace “Essentials”

First make sure the Essentials workplace is activated. If it has a 

check mark next to it, that means its activated.



In the menu bar, click on Window > Workspace > Reset Essentials. 
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Workspace

Your photoshop should now look like this when you 
have a photograph or document open!



2 0  P H O T O S H O P  F O R M U L A S

INDEX

S-Curve

Overlay Mode

Content-Aware Fill

Close Stamp

Hue/Saturation

Color Blending Mode

Smart Objects

Heal Brush

Select Subject

Smart Filters

Vignetting

Screen ModeMultiply Mode

Sky Replace

Group Masks

Layer Mask

Clipping Mask Free form Tool Dual-Monitor Create a Flat 

Copy of Layers



F O R M U L A  0 1

The ability to copy an area 
from one section of a photo 
and place it elsewhere.

CLONE

STAMP



The clone tool allows you to replace one part of an 
image with another part of the image. This feature 
is often used to duplicate or remove an object, such 
as an unwanted person or item in the background. 

1 of 3

2. Select the Clone Stamp Tool

With your image open, click on the Clone 

Stamp Tool in the toolbar on the left side of 

the screen. Or press the ‘S’ key as a shortcut.

1. Duplicate the Background layer

Right click on the “Background” Layer in 

the layers palette on the right side of the 

screen and click “Duplicate Layer”. You can 

name this New Layer, or anything you like.



Now we have a copy of the Background 

Layer, just in case.

CLONE STAMP



3. Adjust the Clone Stamp Size 
and Softness

In the toolbar towards the top left of the 

screen, select the drop-down arrow 

which will open our menu for our Clone 

Brush Size and “Hardness”. 



“Hardness”, often called “Feather” is just  

how sharp or soft the edges of our 

brush are. 



In this example, we are using Size 500 

and the Hardness is set to 0%. This 

allows smoother blending of the Clone 

Stamp Tool.


4. Clone Stamp 
Opacity & Flow.

Make sure  “Opacity” and 

“Flow” are set to 100%. 



These settings just mean how 

transparent something is. In 

this case we do not want any 

transparency.
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CLONE STAMP



6. Begin Stamping

The contents of your brush should show 

the source image referenced within it. 

Choose the space that you would like 

your duplicate to be and click and hold 

down the left mouse button while 

dragging. You now have two of the 

same objects!

5. Select Your Source Area

Hold down Alt (Option on  Mac) and 

your round brush will turn into a 

crosshair icon. Click on what part of the 

image you would like to duplicate. This 

will become our source area because 

our clone stamp tool will reference this 

area when we begin stamping. In this 

example it is the light.
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CLONE STAMP
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The ability to repair “imperfections” 
or copy to the texture of one area to 
another and have Photoshop figure 
out how to blend it. 

HEAL 
BRUSH



The Heal Brush is most often used to remove 
small marks and blemishes from an image 
and is very similar to the Clone Stamp Tool. 

HEAL BRUSH

1. Duplicate the Background Layer

Right click on the “Background Layer” in the Layers Palette 

on the right side of the screen and click “Duplicate Layer”. 

You can name this New Layer, or anything you like.



Now we have a copy of the Background Layer, just in case.

2. Select the Healing Brush

In the left toolbar, click and hold on 

the Healing Brush tool. A menu 

will pop out, select the Healing 

Brush tool.
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3. Select Your Source Area

Similarly, to the Clone Tool, we will 

use the Alt key (Option on Mac) to 

turn your cursor into a crosshair 

icon and select where we would 

like Photoshop to reference when 

healing. 
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HEAL BRUSH

Right click anywhere on your image  

to open your Heal Brush Settings. 

Select the size and Hardness. (Note: 

Hardness refers to how hard or soft 

the edges of the brush are) 



For this photo a brush size of 50px 

with a Hardness of 50% should be 

good since we are working in detail, 

and we want our brush strokes to 

blend gently. 

3. Adjust the Healing Brush Size 
and Hardness
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HEAL BRUSH

4. Heal the area

Click anywhere on 

your image to blend 

the source area with 

the selected area and 

complete your healing. 

5. Keep going!

Sometimes you might 

want to Undo, CTRL + Z, 

(CMD + Z on Mac) and try 

to select a different source 

area and try again. After a 

few tries you should be 

able to achieve the results 

you are going for easily.
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The ability to draw focus 
to the subject or center 
of your image quickly 
and naturally. 

VIGNETTING



1. Choose the Shape Tool

2. Reset Colors to Black & White

For this example we will use the rectangle shape but 

you can choose any shape you want.

Reset your foreground and background colors to black 

& white by pressing “D” on your keyboard.

Vignetting darkens or brightens the edge of the 
photo to draw your eyes towards the center. There 
are many ways of adding a Vignette to an image, 
but we will use a method that makes it so we can 
edit it later easily.

VIGNETTING
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4. Change the Rectangle to be a Border

With your Shape Layer still selected in your Layers Palette 

click the “Subtract Font” button in the Properties Panel. 

This will make it so your rectangle turns into a border 

around the edge instead of a rectangle in the middle of 

your image. 

VIGNETTING

3. Draw a Rectangle

Click and drag from around the top 

left of the photo to draw a rectangle 

around the center of the photo. This 

is the area we want to draw focus to. 
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6. Soften the Effect

5. Change the Mode of the Shape Layer

With your Shape Layer still selected in your Layers 

Palette click “Masks” button in the Properties Panel. 

Now drag the “Feather” slider to the right. The more 

you increase this the softer the effect will become. 

VIGNETTING
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7. Adjust the Vignette Shape

Now you can adjust the shape of the Vignette at any time. 



With the Shape Tool selected (Step 1.) select the Shape Layer 

in the Layers Palette and drag the corners of the shape to 

modify how big or small the Vignette is. 

8. Adjust the Vignette Softness

With the Shape Layer selected, adjust the “Feather” slider 

in the Properties Panel to change how soft or hard the 

Vignette is.



Note: You can use any shape, not just a rectangle to create 

different Vignettes and you can even change the color 

from black to something else for different looks. 

VIGNETTING
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The ability to hide parts of 
a layer without removing 
them permanently. 

LAYER 
MASKS



A Layer Mask allows you to hide parts of a Layer 
without actually erasing them. The great part is you 
can bring those hidden areas back any time you 
want by editing the Mask, not the Layer.

LAYER MASKS

1. Choose the Elliptical 
Marquee Tool

In the left Toolbar, click and hold on 

the Marquee Tool. A menu will pop 

out, select the Elliptical Marquee Tool.



The tool is called the Marquee Tool 

because the little dotted border looks 

like the flashing lights around a 

marquee theater sign. 



Elliptical just means “round”.

2. Draw a Circle

Click and drag to draw a circle with 

the Elliptical Marquee Tool, hold 

down Shift while drawing the circle 

to make it a perfect circle instead of 

an oval.
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LAYER MASKS

3. Create the Mask

At the bottom of the Layers Palette, click 

the Mask Icon (looks like a box with a 

hole in the center).

4. Layer With a Mask

Now you have an image with a Mask. 

You can see the Mask next to the Layer 

in the Layers Palette. 



You can see a small white border 

around the mask which means the 

mask is selected, not the layer. This 

allows you to adjust the mask without 

affecting the layer.
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LAYER MASKS

5. Done!

The checkered pattern behind the image is Photoshop telling 

you that this area is transparent, or has no pixels. We can now 

drag and drop other Layers into this document behind this 

Layer as in the cover example.
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The ability to instantly get 
more “pop” in your image.

S-CURVE



The “S-Curve”, so named because it looks like 

the shape of the letter S, is one of the most used 
“quick adjustments” to any photo that appears 
washed out, or lacks contrast.

S-CURVE

1. Create a Curves 
Adjustment Layer

In the Layers Palette click the 

bottom button that looks like a 

half moon choose “Curves...”. 

This will make a Curves 

Adjustment Layer above 

your Background Layer.

1 of 3



S-CURVE

2. Select the Curves Layer

Select the Curves Layer by clicking anywhere 

on the Curves Layer in the Layers Palette.

3. Shape the First Part of 
Curve Like an ‘S’

In the Properties Panel (just above the Layer 

Palette) click and drag down in the first 

section of the curve.



This will make the darker tones (shadows) 

even darker in your image. 

4. Shape the Second Part of 
Curve Like an ‘S’

In the Properties Panel click and drag up in 

the last section of the curve.



This will make the brighter tones (highlights) 

even brighter in your image.



You can drag the points up and down and left 

and right at any point to increase or decrease 

the effect. 
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S-CURVE

5. Adjust to Taste

The more the curve looks like an S 

shape the stronger the contrast will be 

(darker shadows and brighter 

highlights). You can adjust the curve at 

any time by selecting the Curves Layer 

in the Layers Palette and adjusting the 

curve in the Properties Panel. 
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The ability to change any 
color in your image to 
another color. 

HUE /
SATURATION



Hue is the difference in color that is visible to the 
eye and Saturation is the intensity of the color.

HUE/SATURATION
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1. Create a Hue/Saturation 
Adjustment Layer

In the Layers Palette click the 

bottom button that looks like a 

half moon and choose “Hue/

Saturation...”.

This will make a Hue/

Saturation Adjustment 

just above your 

background layer.



HUE/SATURATION
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2. Select the Hue/Saturation Layer

Select the Hue/Saturation Layer by clicking 

anywhere on the Hue/Saturation Layer in the 

Layers Palette.

3. Select the Color You Want to Change

In the Properties Panel under click the drop 

down list that reads “Master” and select 

whichever color you would like to adjust. For 

this example, we want to change “Cyans” which 

just means greenish-blue.



“Master” means all colors at one, if you adjust 

the Hue or Saturation while “Master” is selected 

you will adjust all the colors of the image.



HUE/SATURATION
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4. Adjust the Colors

In the Properties Panel move the Hue slider to 

the right until it is at “+30”. This gives the water a 

more blue appearance.



And then move the Saturation slider to the right 

until it is at “+25” so the blue is more vibrant.
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The ability to add darker 
objects into a scene.

MULTIPLY 
MODE



A layer with the blending mode “Multiply” will 
darken the layer below it. White disappears.



Blending modes are simply the way you tell 
Photoshop how you want one layer’s pixels to effect 
the layer below. Artists use these all the time to 
quickly create different effects. 

MULTIPLY MODE

1 of 4

1. Choose Two Files

Start by opening two files. One file 

that will act as the background, and 

another file with an object that 

contrasts contrasts with a light 

colored background that we will add 

over the photo. For this example, we 

have a white t-shirt and a drawing.

2. Drag and Drop

With the drawing as the active 

window, click and hold the image 

and drag it to the area at the top 

where your background image is 

(these are called tabs). Once the 

background image becomes active 

release the mouse to drop the image 

on top of the photo.



This will add the drawing as a New 

Layer on top of your photo.



MULTIPLY MODE
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3. Change Blending Mode to Multiply

in the Layers Palette on the right-hand 

side of the screen, click on the arrow to 

open the Blending Mode drop-down 

menu. Select “Multiply”.

4. Size the Layer

Press CTRL + T (CMD + T on 

Mac) to adjust the size of the 

drawing so it fits on the t-shirt. 

Drag the corners of the blue 

outline to adjust the size.



MULTIPLY MODE
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5. Select Move Tool

From the left Toolbar, select 

the Move Tool to place the 

New Layer about where you 

would like it to be on the 

photo. You can adjust this later 

to make it perfect.

6. Remove Lighter Tones

Use CTRL + L (CMD + L on 

Mac) to bring up the Levels 

Popup, and move the right 

slider to the middle. This will 

remove the lighter shades of 

gray from the layer.



MULTIPLY MODE

4 of 4

7. Final Adjustments

Using the Move Tool, or the 

Transform Tool (CTRL + T on 

PC / CMD + T on Mac) make 

any final adjustments to place 

the drawing where you want 

on the photo of the shirt.
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The ability to add lighter 
objects into a scene.

SCREEN 
MODE



A layer with the blending mode “Screen” will 
lighten the layer below it. Black disappears.



Blending modes are simply the way you tell 
Photoshop how you want one layer’s pixels to effect 
the layer below. Artists use these all the time to 
quickly create different effects. 

1. Choose Two Files

Start by opening two files. One file that will 

act as the background, and another file 

with a brighter object in it that we will add 

over the background. For this example, we 

have a night sky and a moon. 

SCREEN MODE
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2. Drag and Drop

Select the Move Tool and with 

the moon as the active window, 

click and hold the image and 

drag it to the area at the top 

where your background image 

is (these are called tabs). Once 

the background image 

becomes active release the 

mouse to drop the image on 

top of the background.



This will add the moon as a New 

Layer on top of your 

background image. 



SCREEN MODE
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3. Change Blending Mode to Screen

in the Layers Palette on the right-hand 

side of the screen, click on the arrow to 

open the Blending Mode drop-down 

menu. Select “Screen”.

4. Adjust Positioning

Now that you can see 

where your moon is, select 

the Move Tool again and 

place it anywhere you’d 

like on your canvas.



SCREEN MODE

5. Adjust Opacity

Continuing in the Layers Palette, adjust the 

Opacity. Opacity refers to how see-through 

or transparent the layer is. 



For this example, I have set the Opacity to 

75% to slightly blend in as if the moon was in 

the distance. 
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The ability to mix two layers 
together to create brighter 
brights and darker darks. 

OVERLAY 
MODE



	� Choose Two Files

For Overlay Mode, you need two files. 

The first file will be your background 

image, and the second file will be the 

texture, pattern, or photo that you will 

mix with the background image.

OVERLAY MODE

A layer with the blending mode “Overlay” will both 
darken and lighten the layer below it. Gray disappears.



Blending modes are simply the way you tell Photoshop 
how you want one layer’s pixels to effect the layer 
below. Artists use these all the time to quickly create 
different effects. 
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2. Drag and Drop

Select the Move Tool and with 

the pattern as the active window, 

click and hold the image and 

drag it to the area at the top 

where your background image is 

(these are called tabs). Once the 

background image becomes 

active release the mouse to drop 

the image on top of the 

background.



This will add the pattern as a 

New Layer on top of your 

background image. 
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OVERLAY MODE

3. Choose Blending Mode

In the Layers Palette, select “Overlay” from 

the Blending Mode drop-down menu. 


Once selected. Photoshop will mix the two 

images to create the Overlay effect. 



Note: If you would like a more subtle effect, 

reduce the “Opacity”. For this image, I like 

the intensity of the Overlay. I kept the 

Opacity at 100% because it looks neat.
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The ability to change 
the color of layers 
with another layer. 

COLOR 
BLENDING 
MODE



A layer with the blending mode “Color” will change 
the color of the layer below it.



Blending modes are simply the way you tell 
Photoshop how you want one layer’s pixels to 
effect the layer below. Artists use these all the time 
to quickly create different effects. 

,* Create a New Layer

Click on the “Create a New Layer” 

icon that looks like a square with a 

plus sign in the lower right of the 

Layers Palette. This will add a blank 

Layer on top of your background.

2. Choose Brush Tool 

In the left Toolbar, choose the Brush Tool. 



For this example, I will be using the Brush Tool 

and Color Blending Mode to change the 

subject’s hair from red to blue.  



COLOR BLENDING MODE
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3. Pick a Color

In the left Toolbar, double-click on the 

Set Foreground Color icon and chose 

any color you like. I have chosen a 

neutral blue. 



4. Adjust Brush Tool Size

In the top Toolbar, click the drop down 

arrow next to the Brush Tool icon to open 

the Tool Preset Picker drop-down menu. 



Adjust the Brush Size and the Hardness. 

(Note: Hardness refers to how hard or soft 

the edges of the brush are) 



For this photo I chose a Brush Size of 

300px and a Hardness of 50% so the 

edges of the brush are soft, but still dense 

enough to be defined. 

COLOR BLENDING MODE
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5. Paint the Section

With the Brush Tool and 

Layer 1 selected, paint over 

the area that you would 

like to change the color of. 

6. Erase Any Mistakes

If you want to erase some of 

the brush you can quickly 

switch to the Eraser Tool with 

“E” and adjust the Size and 

Hardness the same as the 

Brush Tool.

COLOR BLENDING MODE

3 of 4



7. Choose Blending Mode

In the Layers Palette, click to open Blending Mode 

drop-down list and select the “Color” Blending Mode. 



Your painted selection will now blend with the 

Background Layer to change its color.

COLOR BLENDING MODE
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The ability to quickly 
select objects in a photo 
and refine the selection. 

SELECT 
SUBJECT



With the Select Subject Tool Photoshop will try its 
magic and figure out what needs to be selected so 
you don’t have to. It works best when the subject is 
sharp and contrasts against the background.

1. Choose Subject and a Background

For this example, you will replace with 

existing background of the subject with 

another one. Open both files.

SELECT SUBJECT
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2. Choose the Object Selection Tool

In the left-hand Toolbar, click on the Object 

Selection Tool. If the icon is not shown on the 

Toolbar, right-click to open a menu where you 

can choose it. 



SELECT SUBJECT
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3. Select Subject

Click the “Select Subject” at the top of 

Photoshop. This will create a flashing 

dashed line around the perimeter of the 

subject, and that is called a Selection. 

4. Create a Layer Mask

At the bottom of your Layers Palette, 

click on the “Add a Layer Mask” icon. 



SELECT SUBJECT
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5. Drag and Drop Background

After the Mask is created, click on the tab with your 

background image. Select the Move Tool and click 

and hold your cursor on the image, then drag it 

upwards to your tab with the Layer Mask. Once your 

cursor is hovering the image with the Layer Mask, 

release the cursor. 



This will add the background as a New Layer on top of 

your subject. 

6. Rearrange Layers

 In the Layers Palette, click on “Layer 1” and hold down 

the cursor. With the cursor held, drag Layer 1 below 

the layer with the Layer Mask until you see two blue 

parallel lines underneath it. Release your cursor. 



This will have placed the new background of your 

choosing around your subject with the help of the 

Subject Select Tool. 
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The ability to quickly have 
Photoshop replace the sky 
in a photo. 

SKY 
REPLACE



With the Sky Replace Tool you are asking 
Photoshop to figure out what part of the image 
is a sky, and then you choose a new one and 
make color adjustments to blend the new sky in.

1. Choose an Image

It does not matter what 

type of sky is in your 

image, any sky will work. 



For this example, I chose 

a cloudy sky that I would 

like to make blue.

2. Select Sky

Replacement Tool

In the Properties Menu at 

the top of the screen, click 

Edit > Sky Replacement.

SKY REPLACE
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SKY REPLACE
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3. Choose Clouds

Click on the arrow to the right side of the sky 

picture to expand the drop-down menu.



For this example, I chose the third cloud 

photograph from the top since I was aiming for 

a “sunny day” feeling. 

4. More Skies!

Note: If you click the folder next to “Blue Skies”, 

Photoshop provides you with two other sky folders 

“Sunsets”, and “Spectacular”.



You can also upload your own sky photo by 

pressing the “Import Sky Images” icon.



SKY REPLACE

3 of 3

5. Adjust & Blend

After you chose your clouds, adjust the 

sliders to customize the blend of the sky. 

Shift Edge: 


Moves the sky closer or further away from edge



Fade Edge: 


Blurs/Sharpens the edge where sky and photo meet



Brightness: 


Increases the brightness of the sky



Temperature: 


Changes the warmness or coldness of the sky



Scale: 


Makes the sky larger or smaller



Flip: 


If checked will flip the sky horizontally
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The ability to remove 
elements from images by 
having Photoshop fill in the 
details for you. 

CONTENT 
AWARE FILL



With the Content Aware Fill you are telling 
Photoshop to take a section of an image and “fill” it 
in with the details around it. Photoshop will do its 
magic and try and make it seamless.

1. Duplicate Layer 

Since you will be making some 

changes to the image, it is always a 

good idea to make a copy of the 

Background Layer, just in case. In 

the menu at the top of the screen, 

click Layer > Duplicate Layer, then 

press “Ok”. 

2. Select the Marquee Tool

In the Toolbar to the left of the 

screen choose the Marquee 

Tool. Then click and drag to 

make a selection of the area we 

want Photoshop to fill with the 

content around it. I made sure 

to select the slight shadow on 

the ground as well.

CONTENT AWARE FILL

1 of 3
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CONTENT AWARE FILL

3. Fill

Choose Fill from the Edit menu at 

the top of Photoshop.

4. Content Aware Fill

A box will popup. Select “Content 

Aware Fill” from the menu and then 

click OK.
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CONTENT AWARE FILL

5. Photoshop Will “Fill” 
the Area

Photoshop will Fill the area and in 

this case will replace the person 

from the photo with the tiles 

pattern on the ground. Nice job 

Photoshop!

6. Repeat With the Rest of the 
Objects You Want to Remove.

Anything else you wish to have 

Photoshop fill, just use the Marquee 

Tool and select an area and repeat.
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The ability to edit a layer 
without permanently 
affecting it. 

SMART 
OBJECTS



Smart objects in Photoshop are used for non-destructive 
editing, allowing you to scale, rotate, apply many filters, 
all without affecting the source image. 

SMART OBJECTS
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1. Choose Two Files

Start by opening two files. One file 

that will act as the background, and 

another file that we will convert to a 

Smart Object.

2. Convert Layer to 
Smart Object

In the image that will become the 

Smart Object, right click the layer and 

choose “Convert to Smart Object”



SMART OBJECTS
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3. Drag and Drop

With the Smart Object as the 

active window and the Move 

Tool selected, click and hold 

the image and drag it to the 

area at the top where your 

background image is (these 

are called tabs). Once the 

background image becomes 

active release the mouse to 

drop the image on top of the 

background.



This will add the Smart Object 

as a new layer on top of your 

background image. 

4. Transform the Layer

Press CTRL + T (CMD + T on 

Mac) to transform the layer. 

Use the corners of the blue box 

to adjust the size of the Smart 

Object. You can adjust this 

later if you want.



SMART OBJECTS
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5. Change the Blending 
Mode to Multiply

Change the Smart Object 

blending mode to Multiply.

6. Rotate & Transform 
the Layer

Press CTRL + T (CMD + T on 

Mac) to transform the layer. 

Click and drag anywhere 

outside the blue box to rotate 

the layer. Rotate and Size the 

layer until you are happy.



SMART OBJECTS
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7. Double-Click the Layer 
to Open the Original

With a Smart Object, the original layer 

is left unmodified. To see the original 

contents, just double click the layer’s 

thumbnail in the Layers Palette.
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The ability to apply many 
filters and go back and 
adjust them later. 

SMART 
FILTERS



Smart Filters are any effects or adjustments applied to a 
Smart Object. The great thing about these, is you can go 
back and make adjustments to them later without 
worrying about permanently affecting your image. 

%- Apply a filter to Smart Object

First convert your layer to a Smart Object (see previous 

section). With the smart object layer selected in the 

Layers Palette, go to the top menu and choose a filter you 

would like to apply. In this case I am applying the “Oil 

Paint” filter to give the photo a painted look.

SMART FILTERS
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2. Apply the Oil Paint filter

3. Apply more filters to a Smart Object

For this photo I have chosen to put the Stylization 

and Cleanliness sliders as high as they can go. The 

other two sliders don’t do anything (if you don’t have 

lighting on) so I didn’t touch them. 

You can apply any filter or adjustments to the 

smart object as many times as you like. Here I 

have applied the filter “Oil Paint” six times to really 

give it a painted look. 

SMART FILTERS
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5. Adjust the Smart Filter

4. Turn off Smart Filter temporarily 

Double click the filter from below the layer you want 

to edit and the appropriate window will pop up and 

allow you to make adjustments. 

Click the eyeball next to the filter you want to turn 

off. Click it again to turn it back on.



You can turn on/off all filters at once by clicking the 

eyeball next to the “Smart Filters” text. 

SMART FILTERS
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6. Final check Layers Palette

After making any last minute adjustments to the 

Smart Filters, check the Layers Palette to see that 

all the Smart Filters are visible. 



They are all visible if they all have an eyeball icon 

next to them. 
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The ability to remove parts of 
a group of layers without 
removing them permanently.

GROUP 
MASKS



Group masks are a powerful way to organize your 
layers so you don’t have to create the same mask 
over and over again.

1. Select Layers to 
Group Mask

In order to make a Group Mask, 

you will want to place all the 

Layers that you would like to be 

Masked at once in a group folder. 



Hold down the CTRL key 

(Command on Mac OS), and click 

on each layer that you would like 

to be a part of your group. 

2. Create a Group Folder 
With your multiple layers selected, 

press CTRL + G (Command + G on 

Mac OS) to group the layers. 



To ungroup, press Shift + CTRL +G.  

GROUP MASKS
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3. Create a Layer Mask over the Group

With your group selected click on the “Create 

a Layer Mask” icon at the bottom of the Layers 

Palette (Photoshop will have automatically 

named it “Group 1”, you can change this).

4. Fill the Layer Mask with Black

In the Menu Bar at the top of the screen, 

click Edit > Fill. Photoshop will prompt you 

with a dialog box, click to open the drop-

down menu next to ‘Contents’, and choose 

black. Click Ok to close the box. 

GROUP MASKS
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5. Choose the Brush Tool

In the left toolbar, choose the 

Brush Tool that looks like a 

paint brush, or press ‘B’ on 

your keyboard as a shortcut. 



If you do not see the Brush 

Tool, right click on the icon to 

open a mini-menu where you 

can choose the Brush Tool. 

6. Select Foreground and Background Colors

For this next step, you will want your foreground (the color in front) 

to be white, and your background (the color in back) to be black. 



By default, photoshop has set your foreground to black, and the 

background to white. Simply click on swap icon and the foreground 

and background color will switch places, and now your foreground 

should be white. 

GROUP MASKS
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7. Paint the Areas you 
Want Visble 

You will use white ‘paint” to uncover 

parts of the group that you would 

like to see. In this case, I want to 

show some of the light rays around 

the top of the lighthouse.

8. Erase Any Mistakes

If you feel that you made any 

mistakes along the way or would 

just like to clean up a little bit, 

switch your foreground color 

back to black and paint over the 

areas you would like to be 

masked once more. 

GROUP MASKS
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The ability to put one layer 
inside another. 

CLIPPING 
MASKS



Clipping masks are used to control the shape and visibility of 
an image, allowing you to place a layer within another layer.

&* Create a New Document.

In Photoshop’s top menu, choose File > 

New. This will pop open a new screen. 

For this new document, we want it to be 

4368 pixels wide by 6000 pixels tall.



Under Background Contents , choose 

Black as the color.

CLIPPING MASKS
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2. Add Text or Shape 

Choose the Horizontal Type 

Tool, click on the black area 

and type a word or phrase. 

You can change the font size 

near the top, I used 1,226. 



Alternatively, you can use 

the Rectangle Tool or the 

Ellipse Tool to create a shape 

instead of text. 



CLIPPING MASKS
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3. Drag and Drop

With the image that will 

appear inside the text or shape 

as the active tab, select the 

Move Tool and click on the 

image and hold down your left 

cursor. Drag the image to the 

tab with your text. This file will 

become your active tab, then 

release the cursor to 


drop the image on top of 


your background.



This will add the photo 


as a new layer on top of 


your background. 

4. Add a Clipping Mask

Hold “Alt” (Option for Mac OS) down on 

the keyboard and hover in between the 

two layers, your cursor will change into a 

box with an arrow, and click. 



This will place the image inside the text 

or shape and create a “Clipping Mask.” 



CLIPPING MASKS
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5. Adjust with the Move Tool

Once you have created the Clipping Mask, the image 

may not be exactly where you would like it inside the 

text or shape. 



If this is the case, choose the Move Tool and click on 

the canvas with your left cursor and drag it around 

until you are satisfied. Make sure you have selected 

the photo layer in the Layers Palette.
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The ability to change the 
size, rotation and position 
of layers freely. 

FREE 
TRANSFORM



Free Transform, sometimes just called “transforming” 
is the way to move, rotate or scale a layer.

2. Transform CTRL + T 
(CMD + T on Mac)

1. Select the Layer You 
Want to Transform

In the Layers Palette click 

the clouds layer.

Press CTRL + T (CMD + T on 

Mac) to transform the layer. 



Click and drag anywhere inside 

the blue box to move the layer.



Click and drag anywhere 

outside the blue box to rotate 

the layer. 



Click and drag the corners to 

scale the layer up and down.

FREE TRANSFORM
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3. Tip: Link the Scale

When you have the link icon 

selected then scale the layer it 

won’t distort from its original shape.

4. Tip: Unlink the Scale

Without this on, you can scale it in 

either direction causing it to 

stretch wide or tall.
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The ability to optimize 
Photoshop’s layout across two 
monitors for the most optimum 
workflow. 

DUAL-
MONITOR



Many professional designers and artists use 
multiple monitors to be able to work faster. This is 
my suggestion for a very effective, tried and true 
layout for Photoshop if you use two monitors.

1. Main Screen

When using more than a single monitor I do my best to 

keep my primary monitor completely free of all palettes.

DUAL-MONITOR
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2. Second Screen

3. Tip: Snapping Palettes

This is the screen myself and most professionals use to organize 

their tools. Below you will see my preferred layout, but of course 

you can adjust to your preference!

There is a cool trick in Photoshop where 

you can snap a palette to another so they 

move and resize as a single palette. To do 

this, drag and drop a palette from the top 

tab and move it to one of the edges of 

another palette, it will highlight blue.

Layers History Info

Channels

& Paths

Text & 
Presets Libraries Brushes
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The ability to quickly create a 
flattened version of your 
artwork for final touch ups. 

CREATE A 
FLAT COPY

OF LAYERS



One key trick to “finalize” an image, is to apply a 
color correction or adjustment to all the layers at 
once. A great way to do this is create a “flat” (no 
layers) copy of your entire document as a single 
layer, without losing your layers.

1. Have your file open

For this example, I have been 

editing this photograph and 

ended up with several layers. I 

would like to edit the layers as 

one to make a few final 

adjustments. I don't want to 

merge all of the layers together 

so I can go back and edit them 

individually if necessary. Any 

image with multiple layers will 

work for this.

2. Create Duplicate of Merged Visible Layers

For Mac hold Option + CMD + Shift  and then press E.


For Windows hold Alt + CTRL + Shift and then press E.



This will create a new layer titled “Layer 1” that is a 

duplicate of the all the visible layers below.

CREATE A FLAT COPY OF LAYERS

1 of 2



3. Add any Final Touches

Now you can add any last adjustments to 

your image without having to do each 

layer individually. I added some Smart 

Filters for some final touches. 
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I’m happy you are on your path to 

create your amazing art and 

hopefully have a lovely career or 

hobby. I hope you learned a few 

new tricks and tools from this book. 

Feel free to contact me or check 

my site for more tips and tricks!

www.kelvindesigns.com

THANK YOU!




